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1. INTRODUCTION 

1.1 OVERVIEW MBScope is a Windows-based software suite of monitoring and servicing 

tools that interface with SKF Magnetic Bearings’ controllers. This manual 

contains comprehensive information on the use of MBScope for 

operation of the MBG5PC system. 

The servicing manual is provided in a separated document [2] for factory or 

expert users; it contains instructions for configuring and changing parameters 

inside the controller. 

1.2 SOFTWARE This user manual describes MBScope version 4.2.X. 

1.3 DEFINITIONS / ABBREVIATIONS  

Controller 

 

Magnetic Bearing Controller 

 

DSP Digital Signal Processor (a subsystem of the controller). 

 

MBCS Magnetic Bearing Control System – Include the 

Magnetic Bearing Controller and remote monitoring 

system  (MBScope) 

 

Parameter  

 

A parameter is a controller variable that is used for 

transferring permanent or temporary information 

between the controller and MBScope. A parameter may 

be a boolean, integer, floating-point or other value type, 

or a vector of such values.  

  

Sampled Data Analog data that is sampled by the controller at a 

pre-defined sample frequency. 

 

SDR 

 

Shutdown Request. An event causing the system to 

shutdown. 

 

Snapshot 

 

A temporal window of sampled data such as a position, 

current or voltage. 

 

SPV 

 

Supervisor Board (a subsystem of the controller). 

TDC Top Dead Center. Alias for the speed sensor in a 

magnetic bearing system. 

 

Tick A 64-bit integer representation of a date-time value in 

units of 1E-7 seconds. 
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1.4 GENERAL REQUIREMENTS The general minimum and recommended software and hardware 

requirements to run MBScope are the following: 

 

Operating System: Windows 7, Windows Server 2008 

Processor: Minimum: 2 GHz Dual Core or Greater 

Memory: Minimum: 4 GB 

Recommended: 8 GB or Greater 

Free Disk Space: Minimum: 100 MB 

Recommended (for trending): 1 GB or Greater 

Screen Resolution: 1280 x 1024 or Greater 

Ethernet 

Bandwidth 

Minimum: 100 Mbit/s  
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2. INSTALLATION 

2.1 GENERAL Installation and proper operation of MBScope on Windows systems requires the 

user to have administrative access to the local machine. If you find that you are 

being restricted from installing or using MBScope with warnings that indicate “you 

do not have permission”, please contact your local system administrator. 

2.2 INSTALLATION To begin installation of MBScope, insert the MBScope CD into the drive. An 

installation program should automatically run within a few moments. If the program 

does not run automatically, execute MBInstaller.exe from the drive where the CD 

was inserted.  

 

 

Figure 1 – SKFMB Installer 

 

A list of all components to be installed (and already installed) is shown in the 

installer window. Click on the Install All button to begin installation. When the 

confirmation window appears, click Yes to proceed.  

 

 

Figure 2 – SKFMB Installer : Confirmation 
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2.3 MBSCOPE SOFTWARE 

INSTALLATION 

Once MBScope. installation begins, you should see the following Setup Wizard : 

 

 

Figure 3 – MBScope Install : Setup Wizard Welcome Page 

 

Click Next to proceed to the License Agreement page.  

 

 

Figure 4 – MBScope Install : License Agreement 

 

You must read and agree to the license agreement before continuing with the 

installation. If you agree, click Next to proceed to the Installation Folder page.  
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Figure 5 – MBScope Install : Installation Folder 

 

Once you have configured the Installation Folder, click Next to proceed to the 

Confirm Installation page of the wizard. 

 

 

Figure 6 – MBScope Install : Confirm Installation 

 

Click Next again to begin copying and installation of the files required to run 

MBScope. 

 

When installation is complete, click Close to exit the Setup Wizard. 

2.4 LICENSE MANAGER 

INSTALLATION 

Once MBScope is installed, you may be prompted to install the License Manager. 

The License Manager is required for the operation of MBScope.  
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Figure 7 – License Manager Install : Setup Wizard Welcome Page 

 

Click Next from the Setup Wizard Welcome page to begin installing the License 

Manager. The installation wizard will take you to the License Agreement page. 

 

 

Figure 8 – License Manager Install : License Agreement Page 

 

You must read and agree to the license agreement before continuing with the 

installation. If you agree, click Next to proceed to the Installation Folder page.  
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Figure 9 – License Manager Install : Installation Folder 

 

Once you have configured the Installation Folder, click Next to proceed to the 

Confirm Installation page of the wizard. 

 

 

Figure 10 – License Manager Install : Confirm Installation 

 

Click Next again to begin copying and installing the files required to run the SKF 

License Manager. 

 

When installation is complete, click Close to exit the Setup Wizard. 

2.5 INSTALLATION 

COMPLETE 

At this point, MBScope should be properly installed. It is now safe to Exit the 

SKFMB Installer.  
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3. MBSCOPE TOOL SUITE 

3.1 OVERVIEW MBScope consists of a number of monitoring and servicing tools that interface with 

SKF Magnetic Bearings’ controllers.  

3.2 MONITORING AND 

DIAGNOSTIC TOOLS 

Monitoring tools are used for capturing and/or displaying sampled data and/or 

parameters from the controller. The following tools are provided as part of the basic 

MBScope suite: 

 

Tool Description 

Control Panel  Used for basic monitoring and issuing control-command 

operations. 

Event Viewer Retrieves, displays and stores alarm information collected by 

the controller when the magnetic bearing is shutdown 

abnormally and the controller’s event log.  

Snapshots Tool Displays real-time snapshots from the controller in the time 

domain, frequency domain, or as statistics in tabular form. 

Orbits Tool 

 

Displays information about the speed and orbit of the shaft in 

real-time.  

Trending Tool Captures real-time, transient or windowed data from the 

controller for post-viewing or processing.  
 

3.3 SERVICING TOOLS Servicing tools provide the functions necessary for SKF and certified personnel to 

tune and configure the controller. The following servicing tools are optionally 

available as part of the MBScope suite depending on your contract agreement: 

 

Tool Description 

Calibration Tool Used for aid in mechanical sensor calibration, digitally 

calibrating position sensor offsets and sensitivities, 

checking machine internal clearances, and verifying 

alarm levels and functionality.  

Firmware Loader Used for updating controller firmware. 

Parameter Loader Used for sending and receiving parameters to and from 

the controller through a PVF. 

Service Panel 

 

Used to calculate the system transfer functions by 

injecting various frequency signals into the bearings. 
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4. LICENSING 

4.1 OVERVIEW MBScope use is restricted through licensing primarily to prevent failure or damage 

to SKF magnetic bearing systems due to misuse of the software.  

 

There are two standard MBScope licenses available: 

 

 Basic License 

 Certified User License 

 

Figure 11 describes the availability of each MBScope Tool based on the license 

granted.  

4.2 LICENSE FILES Licensing is controlled using a license file that is installed for a specific Windows 

User Account using the SKF License Manager. Restricting the license file to a 

particular user account allows different users on the same PC to have different 

MBScope privileges.  

 

For example, ‘User A’ may be an applications engineer responsible for tuning new 

magnetic bearings thus requiring certified user access to MBScope, while ‘User B’ 

may be a technician who monitors the system from time to time but does not need to 

change anything, therefore requiring only minimal access to MBScope.  

4.3 BASIC LICENSE Contact SKF to receive a basic license key free of charge. In general, only basic 

features are permitted with a basic license. 

This is the recommended privilege level if you only wish to view data from the 

magnetic bearings and avoid making inadvertent changes to the system. 

4.4 CERTIFIED USER 

LICENSE 

A certified user license is typically granted to OEMs capable of commissioning and 

servicing a magnetic bearing product purchased from SKF Magnetics Bearings.  

 

Since the certified user license permits modification of system parameters, it is 

strongly recommended that this license is distributed only to individuals 

properly trained to tune or maintain the SKF magnetic bearing system.  

4.5 LICENSE FILE 

INSTALLATION 

If you received a license key with your copy of MBScope, then you should first 

install it using the SKF License Manager prior to using MBScope. Please refer to the 

SKF License Manager User’s Guide (SKF# 892-0095)  for information. 

 

4.6 ADD-ON LICENSES Custom engineered MBScope tools may require a unique license in addition to the 

standard MBScope licenses. In this case the appropriate product key may be 

requested or purchased from SKF Magnetic Bearings. 
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Figure 11 – MBScope License and Tool Availability 
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5. APPLICATION LAUNCHER 

5.1 OVERVIEW The Application Launcher provides a quick and convenient interface for launching 

MBScope Tools directly from the desktop or the system tray. 

5.2 LAUNCHER TOOLBAR The Launcher Toolbar provides quick and convenient interface to launch MBScope 

Tools directly from the desktop. 

 

Figure 12 – Launcher Toolbar 

To launch MBScope Tools from the toolbar, click on the “Launch Tool” button and 

select the desired tool. 

 

To configure the toolbar or launch special features click on the  icon and select 

one of the menu items described below: 

 

 

Figure 13 – Toolbar Options 

 

 Locked – Prevents the toolbar from being 

moved 

 Always on Top – Maintains the toolbar as the 

top most window 

 Start Minimized – Starts the launcher in the 

system tray 

 Auto-Updates – Enables or disables 

automatic checking for MBScope updates 

 Import PEF/MDL – Allows an MBScope 

PEF or MDL file to be imported 

 User Interface Settings – Launches the User 

Interface Connection Dialog (Section 8) 

 Connection Settings – Launches the 

Communication Settings Dialog (Section 6) 

 MBPlugin Manager – Launches the 

MBScope Plugin Manager 

 MBLicense Manager – Launches the 

MBScope License Manager 

 MBDataEngine Configuration – Opens a 

dialog for configuring the MBScope server 

 View Comm Stats – Displays 

communications statistics 

 Check for Updates – Check for MBScope 

updates 

 Help/About – Shows the MBScope About 

Box 

Note: When the Launcher Toolbar is closed, the Launcher System Tray Icon will 

remain available. 

5.3 LAUNCHER SYSTEM 

TRAY ICON 

The Launcher System Tray Icon provides quick and convenient interface to launch 

MBScope Tools directly from the system tray. 



Applications  

 Software User’s Guide – MBScope MBG5-PC 

892-0110 Rev C.doc 

This document is confidential and proprietary to SKF Magnetic Bearings, a unit of SKF Canada Limited. 

12 

 

 

Figure 14 – System Tray Icon 

To launch MBScope Tools from the system tray, left-click on the  system tray 

icon and select the desired tool. 

To restore the Launcher Toolbar when it is minimized, double-click on the  

system tray icon. 

To shut down the Application Launcher, right-click on the  system tray icon and 

select Exit. 
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6. CONNECTION SETTINGS 

6.1 OVERVIEW The Connection Settings dialog allows you to configure MBScope communications. 

It can be launched directly from the Application Launcher or from within most 

MBScope tools. The dialog consists in drop down menu with each type of vendor 

controller architecture.  

 

Figure 15 – Connection Settings Dialog 

6.2 MBDATAENGINE URL The MBScope Server Path is the network path on which the MBScope server 

resides. Normally, the MBScope server resides on the same computer as the client 

tools, so this should be configured to ipc://mbserver. 

6.3 SYSTEM 

ARCHITECTURE 

The System Architecture allows the user to connect to various SKF controller types. 

For use with the G5 system, this should be set to MBG5PC. 

6.4 SETTINGS The following communication options can be configured for MBG5 controllers:  

 

System Connection 

System IP Address The IP address and port of the MBG5PC 

Override Snapshot 

Port 

The port that the controller will send snapshot packets to. 

Leave unchecked for an automatic port. 
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7. COMMON MBSCOPE.NET TOOL FEATURES 

7.1 OVERVIEW This section describes features that are common to most MBScope Tools.  

7.2 STANDARD USER 

INTERFACE 

The standard MBScope user-interface may consist of a File Drop Down Menu, a 

Toolbar, a Cursors box and a Connection Status Bar. 

 

 

 

 
 

 

Figure 16 – Standard User Interface 

7.3 CONNECTION When a MBScope Tool is launched, it will automatically attempt to connect to the 

default controller.  

 

If the connection fails, the Connection Settings Dialog will automatically open up. 

You can also open up the Connection Settings Dialog by selecting the File | Connect 

menu option. 

 

The Connection Status Bar located at the bottom of the window indicates the 

connection status of the MBScope Tool. 

7.4 AUTO SCALE The Auto Scale tools allow you to automatically scale a graph for best-fit based on 

the displayed data. The exact outcome of auto-scaling may vary slightly depending 

on the MBScope Tool being used. The Auto Scale tools can be accessed from the 

Tools menu or by clicking one of the   or  toolbar icons.  

7.5 SET SCALES The Set Scales dialog allows you to manually change the extents of a graph. It can be 

accessed from the Tools menu, by clicking the  or  toolbar icons, or by right-

clicking an axis line on the graph. 

 

Connection Status Bar 
Cursors 

File Drop Down Menu 

Toolbar 
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Figure 17 – Set Scales Dialog 

Some tools (ie. Snapshots) allow you to define a different Y-axis scale per-channel 

from the Tools | Set Scales | Main Axes menu option. 

 

You can change the default scale for a particular type of channel by checking the 

“Set as Default” checkbox. The default scales for each applicable MBScope Tool 

are saved to disk and restored each time you use the tool. 

7.6 SETTING SCALES FOR 

INDIVIDUAL CHANNELS 

To set scales of individual channels, select the Tools | Set Scales | Channel x 

selection. 
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A menu will appear allowing entry of the Y scale for the selected axis. 

 

7.7 PANNING You can pan a graph by sliding the horizontal or vertical scrolls bars located at the 

edges of the graph. 

 

 

Figure 18 – Panning 

7.8 ZOOMING For MBScope Tools supporting zooming, you can enter zoom mode from the Tools 

menu, by clicking the  toolbar icon or by pressing ‘z’ on the keyboard. Once in 

zoom mode, zooming is achieved using click-once or drag-and-drop zooming. 
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7.8.1 CLICK-ONCE ZOOMING 

For Click-Once Zooming, 

 

 Left-click on a point within the graph to zoom 2x toward that location. 

 Right-click on a point within the graph to zoom out 2x from that location. 

7.8.2 DRAG-AND-DROP ZOOMING 

For Drag-And-Drop Zooming, 

 

 To zoom in to a specific area on the graph, left-click and drag the magnifying 

glass from the top of the desired area to the bottom of the desired area.  

 To zoom out from a specific area on the plotter, left-click and drag the mouse 

from the bottom of the desired area to the top of the desired area.  

7.9 CURSORS Cursors are used to capture coordinate data from a graph when data collection is 

stopped. 

 

Active Channel Indicator (axis color)

Active Channel Indicator (bolded channel label)

Snapped Cursors

Auto-Cursor

Snapped Cursor Data  

Figure 19 – Cursors 

7.9.1 ACTIVE CHANNEL 

The Active Channel is the channel whose data values are represented by the cursors. 

The Active Channel can be changed by left-clicking the associated channel label or 

the channel plot within the graph. It is indicated primarily by the color of the vertical 

axis within the graph (or sometimes by a bolded label) as per Figure 19. 

 

7.9.2 AUTO CURSOR  

The Auto-Cursor automatically locks onto the data coordinates closest to the mouse 

position of the Active Channel. For clarity, the color of the Auto-Cursor is the same 

as the Active Channel color. 
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7.9.3 SNAPPED CURSOR 

There are two available Snapped Cursors (blue and green) that can be manually 

snapped to data coordinates. To snap a cursor in place: 

 

1. Move the Auto-Cursor to the desired location 

2. Click the right-mouse button to bring up the cursors pop-up menu  

3. Select the desired cursor to snap to the selected coordinates of the Active 

Channel.  

Once a cursor is snapped in place, the cursor’s coordinates are displayed in the ursors 

Box. 

 

7.10 CLEARANCE LIMITS The following MBScope tools allow the ISO vibration limits and/or API clearance 

limits to be displayed: 

 

 Calibration 

 Snapshots 

 Trending 

 Orbits 

 

The limits can be enabled and disabled from the Tools menu of each MBScope 

program. 

 

Figure 20 – ISO/API Limits in Tools Menu 
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8. MBSCOPE.NET USER INTERFACE SETTINGS 

8.1 OVERVIEW This section describes the configurable User Interface Settings available to the 

MBScope Tools.  

These options are brought up in each MBScope Tool, by selecting the ‘Setting’ 

options in the ‘Tools’ menu, or in the Launcher. 

 

 

Figure 21 – User Interface Settings : Location in MBScope Tools 

 

Figure 22 – User Interface Settings : Location in MBScope Launcher 

8.2 LANGUAGE 

 

Figure 23 – User Interface Settings : Language Options 

This menu will allow the user to select the language that MBScope will use to 

display messages to the user. 
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8.3 STATUS BAR 

 

Figure 24 – User Interface Settings : Status Bar Options 

This menu will select what information will be provided on the status bar of each 

MBScope Tool. 

 

 

 

Figure 25 – User Interface Settings : Status Bar Options Example 

UTC stands for ‘Coordinated Universal Time’, and is a time-zone independent value. 

8.4 EVENT VIEWER TOOL 

 

Figure 26 – User Interface Settings : Event Viewer Tool 

This menu provides the option of displaying the Event Log times in UTC format. 

MBC Time Display System Time Display 
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9. CONTROL PANEL 

9.1 RESTRICTIONS This tool is subject to licensing restrictions. See the section on licensing for more 

information. 

9.2 OVERVIEW The Control Panel is a basic system monitoring and control command tool. It allows 

the user to command the system, and to configure analog outputs for debugging / 

monitoring. 

The user can monitor the following system status parameters and registers through 

this main panel: 

 Firmware Version: The firmware version currently installed. 

 System State: The levitation state of the system. 

 Motor State: The rotation state of the system. 

 Motor Control: Control buttons for Levitation and Rotation 

 Alarm Log: A list of system alarms 

 Control Mode: The current control mode of the controller 

 Store Parameters to Permanent Memory: Allows parameters to be written to 

the controller’s permanent memory 

 

 

Figure 27 – Control Panel(Certified User) 

 

9.3 CONTROL COMMANDS 

(Certified Feature) 

The Control Panel allows the user to issue the following Control Command requests 

to the controller:  
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 Motor Control: Levitate / de-levitate the rotor and start the motor. 

 Clear Alarms: Clear latched alarms. 

 Test Mode: Place the controller into test mode (rotation inhibited) 

 

In addition, the Control Panel will allow the user to set the Control Mode. Valid 

selections are: 

 Hardwire: Control is made by MBScope 

 Request: Control must be requested by MBScope or the controller panel 

 Free For All: Control is made by both MBScope and the controller panel 

Note that monitoring information is always available while in any mode. 
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9.4 MBRESEARCH The ‘MBResearch’ tab of the Control Panel allows the user to select and configure 

the DAC outputs that are available on the optional MBResearch component.  

 

Figure 28 – Control Panel : MBResearch Tab 

9.5 TOOLS There are several Tool options available in the Control Panel: 

 

Figure 29 – Control Panel : Tools Menu 

Alarm Panel: 

Opens the Alarm Panel window 

 

Monitoring Panel: 

Opens the Monitoring Panel window 

 

Settings: 

The ‘Settings’ Menu Option will bring up the User Interface Dialog box, as 

described in Section 8. 
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9.6 MONITORING 

 

Figure 30 – Control Panel : Monitoring 

The Monitoring Panel is used to observe the following analog values, at a refresh 

rate of about 1Hz: 

 Raw Positions: Rotor positions as a percentage of their full scale value 

 Instantaneous Positions: Rotor positions measured in micrometers 

 Peak Positions: Peak rotor positions (over the last 2 seconds) 

 Peak Currents: Peak amplifier currents (over the last 2 seconds) 

 Voltages: Amplifier, motor, bus, and analog interlock voltage 

 Oscillator Voltages: Oscillator voltage 

 Current: Motor Drive current 

 Temperature: Controller and motor temperature 

 Rotation: Rotating speed of the rotor 

 

9.7 ALARMS 

 

Figure 31 – Control Panel : Alarms 

The Alarm Panel is used to observe the following fault information from the MBC. It 
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is updated at a refresh rate of about 1Hz. 

 Bearing Amplifier –Overcurrent: The amplifier is experiencing a short circuit 

event that is causing the output of the amplifier to exceed a hardware shutdown 

limit. 

 Bearing Amplifier – Energy Limit: The amplifier output has exceeded the 

maximum energy design limits and is now actively being limited. 

 Bearing Amplifier – Current Limit: The amplifier has reached the maximum 

designed current output and is now actively being limited. 

 Bearing Amplifier – Command Limit: The amplifier has reached the maximum 

command current (no action is taken) 

 

 Levitation – Position: The shaft has exceeded the maximum position deviation 

criteria at nominal (running speed) frequency. 

 

 Rotation – Landing: The shaft has exceeded the position threshold during a pre 

defined time. 

 Rotation – Overspeed: The speed of the rotor has exceeded the maximum 

designed speed. 

 Rotation – Speed Sensor: Rotation information status has been sent by the PLC 

or MBScope, but the speed sensor does not detect rotation. 

 Rotation – w/o Lev Detection: Rotation of the shaft has been detected by the 

DSP or SPV without being levitated. 

 

 Interlocks – External Fault: The external fault input has been triggered. 

 

 System - Temperature: The indicated temperature (AMB1, AMB2, or PCB) has 

exceeded the specified limits. It may also indicate that the temperature switch in 

the machine has triggered. 

 System – Voltage: This indicates if the main voltage is within the specified 

limits. 

 System – Communication: The SPV is unable to communicate with either the 

amplifier DSP or the position control loop DSP 

 System – Watchdog: A watchdog alarm has occurred and the corresponding 

DSP has been reset. 
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10. EVENT VIEWER 

10.1 OVERVIEW The Event Viewer Tool is used to download and display Alarm Snapshot events 

(generated by the MBC), and to view the event logs of the MBC in real time. 

 

 

Figure 32 – Event Viewer  

10.2 ALARM SNAPSHOT 

FEATURES 

The Alarm Snapshot display is used to show the state of the MBC during an alarm 

event. These alarm events are generated when a Level 3 alarm is triggered. One 

alarm snapshot may be stored in the MBC at a given time. 

To view a particular alarm snapshot, first click on the desired event, and then click 

the ‘Get Alarm Snapshot’ button. This will download the event from the MBC. 

 

Figure 33 – Event Viewer : Alarm Snapshot Selection 

Status Bar Alarm Snapshot Button 

Alarm Snapshot List 

Channel Listing 

Event Data 

Event Log Tab 
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The data is then shown in the graph, defaulting to showing the position values. 

Additional channels can be selected from the channel listing on the left. 

 

Figure 34 – Event Viewer : Alarm Snapshot Data 

This information can then be saved for off-line viewing or for sending to a third 

party via the ‘Save Snapshot As…’ File Menu Option as shown below. 

 

Figure 35 – Event Viewer : Save Snapshot 
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10.3 EVENT LOG 

FEATURES 

The Event Log displays the events that are happening in the MBC. There are several 

features that control the way the tool interacts with the controller. 

 

 

Figure 36 – Event Viewer : Event Log 

Commands 

 Auto Refresh: Checks for new events from the MBC, about once per second. 

Any new events are automatically appended to the end of the log. 

 Get Event Log: Instead of waiting for an update, force a download of any new 

events from the MBC. 

 Clear Displayed Events: Clears all events currently displayed in the event log. 

 Re-Download All Events: Will re-download all events currently stored on the 

MBC. It is recommended to clear the event log view before re-downloading all 

events; otherwise duplicates may appear in the list. 

 

Menu Options 

 File -> Save Event Log As…: This will save the event log in ASCII text format, 

consistent with SKF MBScope documentation 994-0118-002. 

 



Applications  

 Software User’s Guide – MBScope MBG5-PC 

892-0110 Rev C.doc 

This document is confidential and proprietary to SKF Magnetic Bearings, a unit of SKF Canada Limited. 

29 

 

11. SNAPSHOTS  

11.1 OVERVIEW The Snapshots Tool displays windowed data from the magnetic bearing system in 

real-time. Signals can be viewed in the time domain, in the frequency domain, or as 

statistics in tabular form.  

 

 

Figure 37 – Snapshots Tool 

11.2  COMMON FEATURES Please refer to the section on Common Features for more information on cursors, 

panning, scaling and zooming.  

11.3 VIEW MENU To select the type of graph to be viewed, select the View menu. Select Snapshots for 

the time domain, Spectrum for the frequency domain, or Statistics for data on the 

selected channels in tabular form. 

 

 

Figure 38 – Snapshots View Menu 

11.4 CHANNEL SELECTION There are two ways to select the desired channels to view. 

 

11.4.1 CHANNEL TYPE SELECTION 

A channel type (ie. positions, top currents and bottom currents, etc.) can be selected 

from the Channel menu. Once a type selection is made, all snapshot channels will 

change to display the selected channel type. 
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Figure 39 – Channel Type Selection 

11.4.2 DETAILED CHANNEL SELECTION 

Each channel can also be changed individually by right-clicking the channel that you 

want to change and selecting a new channel type and axis from the context-menu. 

Only two unit types (um, A, V, etc.) can be displayed at any given time. 

 

 

Figure 40 – Detailed Orbit Selection 

11.4.3 SHOWING/HIDING CHANNELS 

You can show or hide a channel from view by clicking the middle-mouse button on 

the channel label or by right-clicking on the channel label and selecting the 

Show/Hide menu option. If a particular channel has been hidden, MBScope will 

continue to collect data for that channel but will not display it on the screen.  

 

11.4.4 DISABLING CHANNELS 

You can disable all channels by selecting the Channels | All Off menu option or an 

individual channel by selecting None from the right-click context-menu. When a 

channel has been disabled, MBScope will stop collecting data for that channel.  

11.5 SNAPSHOTS VIEW In Snapshots View, signals are displayed in a time-domain window.  

11.6 SPECTRAL VIEW In Spectral View, signals are displayed in the frequency domain 
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Figure 41 – Snapshots - Spectral View 

 

The spectral resolution can be adjusted using the Tools | Spectral Resolution menu 

option.  

 

Note: At 1 Hz spectral resolutions, the maximum number of channels that can be 

displayed may be limited. 

 

Note: Due to constraints of the controller’s sampling frequency and the FFT 

algorithm, the displayed spectral resolution will not always match the selected 

resolution exactly. 

11.7 STATISTICS VIEW 

 

In statistics view, statistical functions are applied to the sample window and the 

resulting mean, standard deviation and peak to peak values for each axis are 

displayed in tabular form.  

 

 

Figure 42 – Snapshots - Statistics View 

11.8 TDC VIEWING AND 

TRIGGERING 

TDC Viewing and Triggering can be toggled on or off using the Tools | Show TDC 

Marks and Tools | TDC Trigger menu options.  

 

When Show TDC Marks is toggled on, the TDC marks are displayed on the graph.  
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Enabling TDC triggering will synchronize the snapshots with the TDC marks.  

 

 

Figure 43 – Snapshots with TDC triggering 

 

These options are only available in the Snapshots view. 
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12. ORBITS 

12.1 OVERVIEW 

 

The Orbits tool displays information about the speed and orbit of the shaft in real-

time.  

 

Screenshot: 

 

Figure 44 – Orbits Tool 

12.2  NUMBER OF ORBITS The Number of Orbits can be specified in the tool. This setting changes the 

persistence, or number of orbits that are drawn at the same time.   

 

 

Figure 45 – Orbits: Multiple Orbits 
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12.3 TOOLS MENU The Tools menu allows filtering, AC coupling, and the display of ISO Vibration and 

clearance limits to be enabled. 

 

 

Figure 46 – Orbits Tools Menu 

12.4  COMMON FEATURES Please refer to the section on Common Features for more information on cursors, 

panning, scaling and zooming.  
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13. TRENDING TOOL 

13.1 OVERVIEW 

 

Trending is a powerful and easy-to-use data acquisition and viewing tool.  

 

Data gathered by the controller can be trended in several ways, known as High-speed 

trending, Transient Capture, and Low-speed trending.  

 

Previously collected data can be viewed in the Data Collection Viewer. 

13.2  COMMON FEATURES Please refer to the section on Common Features for more information on cursors, 

panning, scaling and zooming.  

13.3 TREND FILE 

INFORMATION 

The Trend File Information box allows you configure the trend file and related 

options. 

 

 
Figure 47 – Trend Information Box 

13.3.1 TREND FILES 

Trend files are generated automatically when the trend data size exceeds 500 MB or 

when a trend is complete. Each trend file is named following the convention 

<DataFolder>\<FilePrefix>yyyyMMdd-HHmmss.tsd where 

 

yyyy= Year including century 

MM = Month  

dd = Day  

HH = Hour in 24 hour time format 

mm = Minutes and 

ss = Seconds.  

 

The format of a trend file can be found in the Trending Snapshot Data File Format 

document, (SKF# 994-0118-001). 

13.3.2 DATA FOLDER 

The Data Folder defines the repository where all trend files will be saved. Enter the 

path of the data folder directly into the Data Folder text box or by using the 

Browse... button. 

13.3.3 FILE PREFIX 

All Trend Files are prefixed with the File Prefix defined.  

13.3.4 TREND DURATION 

The Trend Duration box allows you to change the duration of the trend.  

13.3.5 FILE SIZE 

Once all trend parameters are configured, the estimated total trend file size is 

displayed next to the file name. 
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13.3.6 SAMPLING TYPE 

The sampling type can be set to either High Speed (Real-Time Trending), or Low 

Speed (Low Speed Trending). 

13.4 CHANNEL COLLECTION 

SETUP 

Channels to be trended are selected using the Channel Collection Setup box. 

 

 

Figure 48 – Channel Collection Setup 

 

The tree structure on the left is used to navigate through all available channels. 

Clicking on a [+] will expand the tree showing the signals available for that category. 

To add a channel (or channel group), either double-click on the channel name (or 

channel group), or highlight and click the  button. Once added, the selected 

channel(s) will appear in the Triggered / Collected box. To remove a channel, 

highlight and click the  button. You can also add or clear all channels by 

clicking the  or  buttons. 

 

Note: Warnings may be given if you exceed the recommended maximum number of 

channels. Ignoring these warnings may result in lost packets during the data trend. 

13.5 SAMPLE FREQUENCY The Sample Frequency selection determines how often the data is acquired. It is not 

available in the High Speed sampling mode. 

 

 

Figure 49 – Sample Frequency 

13.6  HIGH SPEED 

TRENDING 

High Speed trending allows you to capture data at the highest resolution permissible 

by the controller. It is generally used for capturing a segment of high frequency data.  
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Figure 50 – High Speed Trending Setup 

The maximum number of channels that can be collected in real-time trending mode 

is controller dependent. On a MBG5 controller, up to twenty (20) channels can be 

collected for an indeterminate amount of time. 

 

To set up a high speed trend, first enter relevant information in the Trend File 

Information box. 

 

Next, choose a set of signals to collect using the Channel Collection Setup box and 

set the Sample Frequency to MAX.  

 

To begin trending, press the Start button. A monitoring window will appear until 

trending is complete. 
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Figure 51 – Monitoring for Trigger Conditions 

 

Once trending is complete, the trend data is automatically saved to disk and can be 

viewed using the Data Collection Viewer screen.  

 

Note: If lost packets occur during trending, you will see strings of zero data 

intermixed with the data you have trended. The zeroes represent instances where 

data packets were lost between the controller and MBScope.  

13.7  TRANSIENT CAPTURE In order to capture transient events, MBScope provides some powerful triggering 

options. For example, the trending tool can be configured to monitor data 

indefinitely until a selected position or current deviation is detected, at which time 

the data surrounding the transient event would be collected and recorded for future 

analysis. Transient capture is similar to Real-Time Trending except the trend begins 

only if some trigger condition is met.  

  

To set up a transient capture first enter relevant information in the Trend File 

Information box. 

 

Next, choose a set of signals to collect using the Channel Collection Setup box and 

set the Sample Frequency to MAX. Enable triggering on the individual channels that 

you wish to use as a Minimum / Maximum Trigger  by selecting the Triggered / 

Collected box next to the channel name. 

 

Finally, setup trigger conditions as per the following instructions using the Trigger 

Setup box.  

 

 

Figure 52 – Trigger Condition Setup 

13.7.1 TRIGGER MODES 

Transient events can be collected in three modes: 

 If none is selected, all data will be recorded. 

 If pre triggering is selected, all data is recorded after a trigger condition is found. 

This means that once a trigger event occurs, the trending process will continue 

for the length of the test duration time. 

 If post triggering is selected, all of the data is recorded before and up to when 

the trigger condition is found. This means that the trend process must run for the 

entire test duration before a trigger condition occurs. Once a trigger event 

occurs, the trending process is complete.  

13.7.2 TRIGGER TYPES 

There are two trigger types available: 

 Minimum / Maximum Triggers – A trigger event occurs if one of the triggered 

channels exceeds the minimum and maximum range defined for its 

corresponding channel type (position, current or voltage).  
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 Event Triggers – A trigger event occurs if any of the selected events take place.  

  

The Trending Tool allows you to choose multiple trigger conditions that are 

combined with a logical “OR”.  

 

For example, to set up a condition that triggers when the rotational speed falls below 

1000, or when the position deviates more than 80 um, the parameters should be 

entered as such: 

 

 

Figure 53 – Example Trigger Condition 

 

To begin transient capture, press the Start button. A monitoring window will appear 

until the trigger condition is met and trending is complete. 

 

 

Figure 54 – Monitoring for Trigger Conditions 

 

Once the transient capture is complete, the captured data is automatically saved to 

disk and can be viewed using the Data Collection Viewer screen.  

 

Note: If lost packets occur during trending, you will see strings of zero data 

intermixed with the data you have trended. The zeroes represent instances where 

data packets were lost between the controller and MBScope.  

13.8  LOW SPEED 

TRENDING 

Low Speed Trending allows the user to record statistics on a magnetic bearing 

system over extended periods of time, typically for monitoring long-term 

performance or system changes.  

 

Low Speed Trending works by sampling a window of data (a series of consecutive 

values) at regular intervals. After each window is collected, a user selectable statistic 

function (ie. mean, standard deviation or peak to peak) is applied. The resulting 

sample value is stored to a file.  
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Figure 55 – Windowed Trending  

To set up a low speed trend, first enter the relevant information in the Trend File 

Information box. 

 

Next, choose a set of signals to collect using the Channel Collection Setup box.  

 

Next, configure the low speed trending parameters.  

13.8.1 WINDOWED TRENDING PARAMETERS 

 

Figure 56 – Low Speed Trending Parameters 

 

The sample frequency specifies how often a window of data is sampled. Select a 

value other than MAX.  

 

The Collected Statistic specifies the statistical function (mean, standard deviation, or 

peak to peak) that is applied to each window of data to form a sample value. 

 

Select Show Preview to graphically display the trend as it progresses. 
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To begin trending, click the Start button.  

 

Trending will continue until the time remaining runs down to zero, or until the Stop 

Trending button is pressed. In both cases, trended data will automatically be saved 

to disk. 

 

Note: If lost packets occur you will occasionally see unusually large spaces between 

sample points.  

13.9 TRENDING PREVIEW The trending preview dialog displays Low Speed Trending data as it is collected 

from the controller. 

 

 

Figure 57 – Trending Preview 

 

While monitoring the trend, you can choose between two views. 

 

 Auto Scroll – Continuously scrolls a limited amount of the most recently 

sampled data points. 

 Auto Scale – Shows all points, up until the internal view buffer is full, at which 

point the oldest values are discarded (though they remain in the file). 

 

Individual channels can be toggled on and off from the Channels to Monitor box by 

toggling the check box next to each channel name. 

13.10 DATA COLLECTION 

VIEWER 

The Data Collection Viewer allows you to display previously captured trend files. 

To access the Data Collection Viewer, click on the Data Collection Viewer tab. 



Applications  

 Software User’s Guide – MBScope MBG5-PC 

892-0110 Rev C.doc 

This document is confidential and proprietary to SKF Magnetic Bearings, a unit of SKF Canada Limited. 

42 

 

 

Figure 58 – Data Collection Result 

13.10.1 LOADING FILES 

A trended snapshot data (.tsd) file can be loaded using the File | Open Data File 

menu option. When loading large files, you may be asked to configure the display 

options shown in Figure 59. 

 

 

Figure 59 – Trending Display Options 

13.10.2 MAXIMUM DATA POINTS TO DISPLAY 

The maximum data points to display limits the number of points that can be drawn 

on the graph. Increasing this value will improve data resolution at the cost of 

performance. Decreasing this value will improve performance but reduce data 

resolution. Typically a value between 10000 to 50000 is suitable for viewing 

magnetic bearing data.  

 



Applications  

 Software User’s Guide – MBScope MBG5-PC 

892-0110 Rev C.doc 

This document is confidential and proprietary to SKF Magnetic Bearings, a unit of SKF Canada Limited. 

43 

 

Once a .tsd file has been loaded, the display span can be changed at any time using 

the Tools | Change Display Span menu option. 

 

13.10.3 DISPLAY SPAN 

The display span defines the maximum X-Axis span to be loaded into memory at 

any given moment. A smaller display span will increase the responsiveness of the 

application but limit the number of samples that can be displayed at any given time. 

A larger display span will allow you to view more samples but the application may 

become less responsive due to more graphic activity on the CPU.  

 

Once a .tsd file has been loaded, the display span can be changed at any time using 

the Tools | Change Display Span menu option. 

 

When the display span is less than the total span of a data file, a horizontal scroll bar 

will appear below the graph. Scrolling this bar will load the next or previous segment 

of data from the file. 

 

 

Figure 60 – Trend Data Scroll Bar 

13.10.4 TREND INFORMATION 

The Trend Information box shows important information about the currently 

loaded trend.  

 

 

Figure 61- Trend Information Box 

 Ctrl Type: The controller type from which the trend was generated 

 Ref Time: The reference (start) time of the trend. This value can be in controller 

hours or real-time. 

 Sample Rate: The trending sample rate. For real-time trends, this value will be 



Applications  

 Software User’s Guide – MBScope MBG5-PC 

892-0110 Rev C.doc 

This document is confidential and proprietary to SKF Magnetic Bearings, a unit of SKF Canada Limited. 

44 

 

Infinity. For windowed trends, this value will be the trending sample rate. 

 Trigger Mode: As defined in section 13.6. 

 Trigger Type: As defined in section 13.6. 

 Trigger Channel: The channel that triggered the trend. 

13.10.5 CHANNEL SELECTION 

The Channels to View box lists all of the collected channels. Each channel can be 

toggled on or off by clicking the checkbox next to the channel name.  
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14. PARAMETER LOADER 

14.1 RESTRICTIONS This tool is subject to licensing restrictions. See the section on licensing for more 

information. 

14.2 OVERVIEW The Parameter Loader facilitates the sending and receiving of parameters to and 

from the controller using Parameter Value Files (PVF). 

  

 

 
Figure 62 – Parameter Loader 

14.3  PARAMETER VALUE 

FILE (PVF) 

A Parameter Value File (PVF) is a text file containing information about one or more 

controller parameters.  

 

Enter the path and filename of the PVF from the Parameter File textbox or by 

searching for the file using the Browse... button.  

14.4  READING 

PARAMETERS FROM 

THE CONTROLLER  

Click the Receive from Controller button to download the parameters from the 

controller to the PVF.  

14.5  SENDING 

PARAMETERS TO THE 

CONTROLLER’S RAM 

Click the Send to Controller button to send the parameter set from the PVF to the 

controller’s random access memory (RAM).  

 

Note: Parameters sent to RAM will be lost when the controller is powered off. 

14.6  VERIFYING PVF 

PARAMETERS 

Click the Verify PVF Parameters button to compare the selected PVF file with the 

parameter set in the controller’s RAM. Once this process is complete, any 

differences between the two PVF files are displayed. 

14.7  TARGET 

SPECIFICATION 

The checkboxes in the Targets section allow the selection of which processors will 

receive the parameters in the PVF file. 

 

Note: In order for the controller to perform correctly, all processors should receive 

the parameters within a PVF file. 

14.8  UPDATE LAST 

LOADED PVF ON 

RECEIVE 

Check this box to update the controller’s “Last Loaded PVF” parameter when a new 

PVF file is sent. This is automatically updated to the currently selected PVF filename 

when specified. 
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14.9  STORE PARAMETERS 

TO CONTROLLER’S 

PERMANENT MEMORY 

When the Parameter Loader is closed, a prompt will be displayed asking to store the 

loaded parameters to the controller’s permanent memory. Selecting “yes” in this 

dialog will write the parameters to the controller’s memory so they will not be lost 

when power is cycled. 
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15. FIRMWARE LOADER 

15.1 RESTRICTIONS This tool is subject to licensing restrictions. See the section on licensing for more 

information. 

15.2 OVERVIEW The Firmware Loader tool is used to upgrade controller firmware.  

 

Figure 63 – Firmware Loader 

 

15.3 PARAMETER BACKUP Back up the controller parameters before loading firmware. After the firmware 

upgrade is complete, reload the parameters to the controller’s permanent memory. 

15.4 FIRMWARE UPGRADE 

PROCESS 
A firmware upgrade is done by simply selecting the file to send, entering in the 

controllers IP address and port, and pressing the ‘Send’ button. 

 

Figure 64 Firmware Loader IP/Port Settings 

Status information will be shown in the status window. This window will indicate if 

the firmware upgrade process was successful or not. 
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16. CALIBRATION 

16.1 OVERVIEW 

 

The calibration tool provides an interface to calibrate the radial and axial position of 

the shaft. 

 

To ensure proper calibration of your machine, please refer to the MBG5-PC 

controller user guide (SKF#892-0117), section 3.6.8, for a detailed calibration 

procedure. 

 

 

Figure 65 – Calibration Tool 

The axis selector allows the individual bearing axes to be isolated so that commands 

are executed on a single axis at a time. 

 

 

Figure 66 – Calibration Axis selector 

 

16.2  CALIBRATION 

CONTROLS 

The calibration controls allow the shaft to be moved. This provides a method for 

calibrating the shaft’s position.  

 
Figure 67 – Calibration Controls 

 

The left step button ( ) will move the shaft one step to the left. 

The left auto-step button ( ) will automatically step the shaft to the left until the 

inflection point is determined. 

The center button ( ) will return the shaft back to its center position. 

The clear button ( ) will clear the most recent calibration results. It will not 
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reset and values which have already been sent to the controller. 

16.3  MEASUREMENTS AND 

OFFSETS 
The measurements section displays information about the instantaneous position of 

the shaft. 

 
Figure 68 – Calibration Measurements 

 

The offsets section allows the hardware and software offsets to be sent to the 

controller after they have been manually entered or calculated by the calibration tool. 

 

 
Figure 69 – Calibration Offsets 

16.4  COMMON FEATURES Please refer to the section on Common Features for more information on cursors, 

panning, scaling and zooming.  
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17. SERVICE PANEL 

17.1 RESTRICTIONS This tool is subject to licensing restrictions. See the section on licensing for more 

information. 

 

17.2 TRANSFER FUNCTION  

OVERVIEW  
The Service Panel tool allows for the system transfer functions to be calculated by 

exciting the system and monitoring the response. 

 

Figure 70 – Service Panel 

 

17.3 SYSTEM INFORMATION The System Information Tab  provides information about the controller. This tab will 

only be shown if the controller firmware supports the parameters.  

 

Figure 71 – System Information  
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The send to controller button will send any updated information to the controller. 

If any of the text is red, it means there are changes that must be sent to the controller.  

 

 

17.4 DATA MENU 

DESCRIPTION 
The Data Menu provides several functions 

 

Figure 72 –Data Menu 

 Load Data Set 

Will load a Data Set file and display the data on the Magnitude and Phase 

plots. 

 Export Data Set 

Will export the currently displayed Data Sets to a selected folder. 

 Clear Loaded Data Sets 

Will clear any loaded Data Sets.  

 Output Options 
Will open the Output Options dialog. (See Section 17.8) 

 

17.5 TEMPLATE EDITOR The Transfer Function Tool uses Configuration Templates to determine the axes to 

be swept and the settings for each axis.  

Templates can be configured directly by using the Sweep Configuration Dialog, or 

preexisting Templates can be moved to the folder by using the Import Button. The 

Sweep Configuration Dialog is opened from the Transfer Function Tab, and clicking 

on the ( ) button.  
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Figure 73 – Sweep Configuration 

 Import Button: Will open a ‘Browse File’ dialog to copy a template into 

the MBScope template Directory. 

 Save Button: Will save the currently configured template. 

 Save As Button: Will open a ‘Browse File’ dialog that allows saving the 

template as a new file. 

 Open Template Folder Button: Will open the template folder in a file 

browser, this will allow manual moving of the templates to and from the 

folder. 

 ‘Modified’ Indicator: If the following icon is showing, it means that the 

current template is modified but the changes have not been saved. 

 

17.6 TRANSFER FUNCTION 

TOOL 
The Transfer Function Tool provides a one click method to collect a complete set of 

machine data along with displaying the machine data.  

In order to open Data to view on the Transfer Function tool. Go to Data | Load Data 

Set from the menu bar.  

Modified 

Indicator 

Import button 

Save as 

Button 

Save button 

Open Template 

Folder Button 
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Several display options can be selected. 

 

Figure 74 – Display Options  

 Wrap Phase 

This will keep the Phase Plot with a maximum of 180° and a minimum of 

180°, any high or lower Phases will be wrapped around. 

 Lock Axes 

This setting will prevent auto scaling of the axes when a different data set is 

displayed. 

 TF Selection List 

Displays a list of the transfer functions available in the dataset.  

 Sweep notes Button ( ) 

This will open the ‘Sweep Notes’ for the currently selected dataset. If notes 

have been saved with the dataset, the icon will turn yellow. ( )  

 

17.7 EXECUTE The Execute Button will perform the sweep based of the settings of the selected 

template. 

 

Figure 75 – Transfer Function Execution Status 
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 Finalize Measurement: 

This will close off the currently executing data set capture and start the next 

data set capture 

 Finalize: 

This will finish off the currently executing data set capture and then stop the 

process 

 

17.8 OUTPUT OPTIONS Output Options allows different settings to be used. By default all settings will be on. 

 

Figure 76 – Output options 

 Compress transfer function output files 

This setting will create a .zip file of the folder containing all of the captured 

data sets. 

 

 Open output folder when process is completed 

This will open the output folder when the sweep is completed. 

 

 Confirm output options before a sweep 

This will open this Output Options dialog before the measurements begin. 

 

 Download PVF file 
This will download the PVF and put it into the output folder.  

 

 Comments 
A short description of the measurements being taken.  
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18. TROUBLESHOOTING 

18.1.1 GENERAL 

MBScope relies heavily on communications, and is sensitive to noise, computer processes and system configuration. Always 

follow configuration recommendations in this guide to ensure reliable operation. When modifying connections, cables, 

settings or installing third party utilities on computers with MBScope installed, it is always a good idea to perform the 

modification in stages, test and check the functionality before continuing. 

 

When using MBScope, it is recommended that you close other applications that may inadvertently affect communications, 

memory or processor cycles. 

18.1.2 WON’T COMMUNICATE. 

1) Is the controller powered? 

Yes. 

No. Turn on controller and wait three minutes. 

  Go to next step. 

2) Are all servicing related Ethernet cables connected? 

Yes. 

No. Connect all servicing related Ethernet cables 

  Go to next step. 

3) Is the computer able to establish TCP/IP connection to 

the controller? 

Yes. 

No. Contact your local administrator to correct this 

problem. 

   Go to next step. 

4) Are you still unable to communicate? 

Yes. Go to next step. 

No. Continue with operation. 

5) Contact SKF Magnetic Bearings for assistance.  

18.1.3 CANNOT OPEN XXX.PEF FILE. 

1) Is there a PEF file installed on your hard drive? PEF 

files are typically installed in the folder 

‘c:\ProgramData\SKF Magnetic Bearings\MBScope 

\PEF’. 

Yes. 

No. Load the correct PEF file from the MBScope Tool 

menu as illustrated in Section 5.2. 

  Go to next step. 

2) Is the software still unable to find PEF file? 

         Yes. Re-install MBScope 

 

No. Continue with operation. 

3) Is the software still unable to find PEF file? 

Yes. Go to next step. 

No. Continue with operation. 

3) Contact SKF Magnetic Bearings for assistance.  
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18.2 EXECUTION 

18.2.1 MBSCOPE IS OPERATING SLOWLY. 

1) Is MBScope the only program running on your 

computer? 

Yes. 

No. Close all programs except MBScope. 

  Go to next step. 

2) Are all servicing related Ethernet cables connected 

securely? 

Yes. 

No. Re-connect all servicing related Ethernet cables. 

   Go to next step. 

3) Have you closed down any unnecessary MBScope 

tools? 

Yes. 

No.  Close down any unnecessary screens. 

   Go to next step. 

4) Is the computer still running slowly? 

Yes. 

No. Continue with operation. 

5) Close down all MBScope Tools, wait for the computer 

to become idle and then load only essential screens.  

 

Is the computer still running slowly? 

 

Yes. 

No. Continue with operation 

6) Shutdown the computer and re-start. 

 

Is the computer still running slowly? 

Yes. Go to next step. 

No. Continue operation 

7) Contact SKF Magnetic Bearings for assistance.  

18.2.2 TEXT APPEARS CUT-OFF 

1) Is your operating system set to use a “normal” font 

size? (Check your Display Properties).  

Yes. 

No.  

Set the font size to “normal”. 

Go to step 2.  

2) Is the text still cut-off? 

Yes. Go to next step. 

No. Continue operation. 

3) Contact SKF Magnetic Bearings for assistance.  

19. PERFORMANCE TIPS 

 

If MBScope appears to be operating slower than normal, the following tips may help enhance performance. 

 

 Do not view too many live snapshot channels at any given time. In the Snapshots and Orbits Tools, keep unnecessary 

channels set to None. 

 Always stop or close unnecessary tools. 

 Ensure that the cabling is of good quality. Use of bad cabling can slow down or halt communications entirely. 

 Avoid using communications port monitors or other non-MBScope statistics-collecting applications while MBScope is 

in operation. 
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20. APPENDIX A: AXIS ORIENTATION 

The notations V13, W13, V24, W24, and Z12 are used to refer to the five axes of control. 

 

Figure 77 – Axis Orientation 

If the housing is rotated 180 degrees, the V and W axis orientations are inverted. 
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